
Smart Building Manager

Customizing
Guide



Table of Contents
1. Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

1.1. Administrative Prerequisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
2. Login to Web UI. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2
3. Start the App. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4
4. Building Topology. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

4.1. Introduction to Building Topology. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
4.1.1. Using Room Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

4.2. Create Building Topology. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
4.3. Modify Building Topology. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

4.3.1. Rename Topology Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
4.3.2. Delete Topology Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10
4.3.3. Change Room Details and Device Assignments . . . . . . . . . . . . . . . . . .  11
4.3.4. Change Global Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12
4.3.5. Change Specific Building Configuration . . . . . . . . . . . . . . . . . . . . . . . .  13

4.4. Managing Building Topology using BIMXML Files. . . . . . . . . . . . . . . . . . . . .  14
4.4.1. Exporting Building Topology into BIMXML File . . . . . . . . . . . . . . . . . . .  14
4.4.2. Importing Building Topology from BIMXML File. . . . . . . . . . . . . . . . . . .  14

5. Technic Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
6. Data Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16

6.1. Define Data point for a room based on Smart Director Apps . . . . . . . . . . . .  16
6.1.1. Managing SmartDirectors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16
6.1.2. Pre-requisites. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16
6.1.3. Discovering SmartDirectors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16

6.1.3.1. 1. Go to Network Administration Perspective . . . . . . . . . . . . . . . . .  16
6.1.3.2. 2. Unlock Device List. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16
6.1.3.3. 3. Go to Left-Hand - Device List . . . . . . . . . . . . . . . . . . . . . . . . . .  17
6.1.3.4. 4. Start MAC-Discovery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
6.1.3.5. 5. Save discovery results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
6.1.3.6. 6. Lock and sync with server . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

6.1.4. Assigning a SmartDirector to a Room . . . . . . . . . . . . . . . . . . . . . . . . .  17
6.1.4.1. 1. Go to Building Administration Perspective . . . . . . . . . . . . . . . . .  17
6.1.4.2. 2. Unlock Building Structure. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17
6.1.4.3. 3. Reviw List of SmartDirector Devices . . . . . . . . . . . . . . . . . . . . .  18
6.1.4.4. 4. Drag SmartDirector to a room . . . . . . . . . . . . . . . . . . . . . . . . .  18
6.1.4.5. 5. Drop the SmartDirector to a room . . . . . . . . . . . . . . . . . . . . . .  18
6.1.4.6. 6. Lock and  sync with server. . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

6.1.5. Release a SmartDirector Assignment from a Room . . . . . . . . . . . . . . . .  18
6.1.5.1. 1. Go to Building Adminstration Perspective. . . . . . . . . . . . . . . . . .  18
6.1.5.2. 2. Unlock Building Structure. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

Smart Building Manager
Customizing Guide

- ii -
© 2023 MICROSENS GmbH & Co. KG, All Rights Reserved



6.1.5.3. 3. Select and delete . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
6.1.5.4. 4. Lock and sync with servere . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

6.2. Datapoint design based on MQTT Data . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
6.2.1. Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
6.2.2. Design the data point . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
6.2.3. Import data point Definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
6.2.4. Summary Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20
6.2.5. Create Datapoint Design sheet as CSV file. . . . . . . . . . . . . . . . . . . . . .  20

6.2.5.1. Header Row . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20
6.2.5.2. Data Row. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

6.2.6. Upload the CSV file to the SBM Server . . . . . . . . . . . . . . . . . . . . . . . .  21
6.2.7. Review the uploaded information in the SBM Portal . . . . . . . . . . . . . . .  22

6.3. Managing History Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22
6.3.1. Enable Data Point History Data Tracking . . . . . . . . . . . . . . . . . . . . . . .  22
6.3.2. Enable History data tracking for a data point related to rooms . . . . . . . .  22
6.3.3. Enable History data tracking for a data point related to technic tree
node . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23
6.3.4. Understand the History Data Tracking using the SBM Database . . . . . . .  24
6.3.5. Understand the History Data Tracking using a Time Series Database . . .  24

6.4. Using Datapoints from Modbus Devices. . . . . . . . . . . . . . . . . . . . . . . . . . .  24
6.4.1. Add Modbus Device Manually . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24
6.4.2. Define Data point Definitions manually . . . . . . . . . . . . . . . . . . . . . . . .  25
6.4.3. Import Data point Definition for MODBUS Devices . . . . . . . . . . . . . . . .  25
6.4.4. Format of the MODBUS Data point design sheet. . . . . . . . . . . . . . . . . .  25

7. Building Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28
7.1. Customize the Room status  cards and room visualization. . . . . . . . . . . . . .  28

7.1.1. Pre-Requisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28
7.1.2. Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28
7.1.3. customize Room Cards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

7.1.3.1. Summary Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28
7.1.3.2. Room Card  Template Overview . . . . . . . . . . . . . . . . . . . . . . . . . .  28
7.1.3.3. Edit the Room Card Template. . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

7.1.4. customize Room Visualization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29
7.1.5. Summary Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
7.1.6. Create Room Visualization Template . . . . . . . . . . . . . . . . . . . . . . . . . .  30

7.1.6.1. Review the settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
7.1.7. Customize Room Visualization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30

7.1.7.1. Summary Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
7.1.7.2. Visualization using Room Templates . . . . . . . . . . . . . . . . . . . . . . .  31

7.1.8. customize Room Visualization for an individual room . . . . . . . . . . . . . .  31
7.1.8.1. Summary Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

Smart Building Manager
Customizing Guide

- iii -
© 2023 MICROSENS GmbH & Co. KG, All Rights Reserved



7.1.8.2. Create Room Visualization Template . . . . . . . . . . . . . . . . . . . . . . .  31
7.1.8.3. Review the settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

7.2. Customize the visualization for floors . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
7.2.1. Pre-Requisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
7.2.2. customize Floor Visualization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
7.2.3. Summary Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
7.2.4. Create a Floor Visulaization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

7.2.4.1. Review the settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
8. Alarm and Event Handling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

8.1. Using the Alarm and event centre (AEC) of the SBM WEB UI . . . . . . . . . . . .  33
8.1.1. Pre-Requisite . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
8.1.2. AEC Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
8.1.3. The Alarm Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
8.1.4. The Event Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
8.1.5. The Alarm Rules Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  34
8.1.6. Create or update Alarm Rule definitions . . . . . . . . . . . . . . . . . . . . . . .  35

9. Task Scheduling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37
9.1. Using the Scheduler for automation . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

9.1.1. Pre-Requisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37
9.1.2. Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37
9.1.3. The Basic workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38
9.1.4. Define Schedules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38
9.1.5. Define Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39
9.1.6. Review Schedules using the Caledenar View . . . . . . . . . . . . . . . . . . . .  39
9.1.7. Review the execution of  tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

10. Charts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
10.1. Customizing Charts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40

10.1.1. Pre-Requisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
10.1.2. The core features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
10.1.3. Using built-in charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
10.1.4. Custom Charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
10.1.5. Global charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40

11. Data Dashboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
11.1. Custom Dashboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

11.1.1. Pre-Requisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
11.1.2. Core features of Custom Dashboards . . . . . . . . . . . . . . . . . . . . . . . .  41
11.1.3. Dashboard  Editor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

11.1.3.1. List of available widges . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
11.1.4. The Standard ECO Dashboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42

12. 2-D-Density Plots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43
12.1. 2D-Density Plots. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

Smart Building Manager
Customizing Guide

- iv -
© 2023 MICROSENS GmbH & Co. KG, All Rights Reserved



12.1.1. Summary Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43
12.1.2. Important hints . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

13. Zone View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44
13.1. Customize Zones . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

13.1.1. Pre-Requisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44
13.1.2. Overview about Zones. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

14. Using Design Sheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
14.1. Scope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
14.2. First Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45

14.2.1. Create Data Point Design Sheet . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
14.2.2. Upload to SBM Server instance. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
14.2.3. Review Imported Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

14.3. Advanced Customizing Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46
14.3.1. Customize Building Status (Room Cards and Panels). . . . . . . . . . . . . .  46
14.3.2. Customize Room Visualization . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

Smart Building Manager
Customizing Guide

- v -
© 2023 MICROSENS GmbH & Co. KG, All Rights Reserved



Chapter 1. Introduction
The SBM Web Client is the key tool for customizing the SBM Server to a particular
building project.

The key customization topics are listed here below:

• Setting up the building topology.

• Setting up the device network.

• Setting up central technical services (Technic Tree).

• Designing data points.

• Using visualization portlets.

• Setting up alarm and event handling.

• Setting up history data handling ("History Charts").

• Setting up building specific properies for an "Eco Dashboard".

• Setting up automation of tasks based on a scheduler.

• Setting up user management.

1.1. Administrative Prerequisites

Before using the application for operational tasks, the prerequisites must be as fol­
lows:

• Valid login on the local computer.

• Application’s server instance is started.

• User account has the right to start the application via web client.

• Valid server licence key file is uploaded to the server.

Smart Building Manager
Customizing Guide

- 1 -
© 2023 MICROSENS GmbH & Co. KG, All Rights Reserved



Chapter 2. Login to Web UI
After starting the server instance, a web browser can be used to access the server
with one of the following URL addresses. You can find the server IP address and the
server port on the bottom left corner of the server manager window right below the
status list.

For secured HTTP connections, if the secured HTTP was not unchecked
https://<server_ip_address>:<https_server_port>/

For standard HTTP connections http://<server_ip_address>:<http_server_port>/

You have to insert valid credentials into the login screen before accessing the Web UI
of the application’s web server.


A user account with administrator access rights (e.g. "Super Admin" )
is mandatory to make changes in the respective application.

Figure 1. WEB UI - Login Screen



Depending on the user’s access level, the Web UI opens with several
application tiles for:

• Building Management

• Building Configuration
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• Device Management

• User Management

• Licence Management

• Server Configuration

If you do not see one or more of these tiles you do not have the
respective access level for this application.
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Chapter 3. Start the App


Depending on the user’s access level, the Web UI opens with several
application tiles. If you do not see a specific tile you do not have the
respective access level for this application.

There are two possible ways to start the app:

Directly on login
After successfull login into the Web UI, the tiles of all available applications appear.

Click on the tile of the application you want to open.

Figure 2. Web UI - Application "Building Configuration"

The respective application’s start page opens.

Changing apps
As long as another app is active, you have to logout of the active application first by
selecting <user> › Select app from the drop-down menu on the top right of the
web UI.
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Figure 3. Web UI - User Menu

The tiles of all available applications appear (see above).
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Chapter 4. Building Topology

4.1. Introduction to Building Topology

This section provides a brief explanation of the main function, which is to modify the
project’s "building structure".

There are two ways to determine a building topology:

Defining the building topology manually
SBM allows you to define a hierarchical building tree manualyl with

• Location

• Buildings

• Floors

• Rooms

Import the building topology from XML files
SBM supports the export and import of building structures using XML files. The XML
files are also known as BIM files.

With the help of this tool, you may define a building topology for your test environ­
ment. The topology can be exported and imported into your productive environ­
ment. The building topology does not need to be manually defined twice.

4.1.1. Using Room Types

The concept called "room types" is very useful in the following cases:

• Managing a building with multiple rooms of the same properties or type of room
automation.

• Creating your own room visualization with uploading a portlet for room visualiza­
tion that will be utilized in all rooms of the same type.

4.2. Create Building Topology

Follow these steps to create a new building topology.

1. In the navigation pane click on Building Customization › Building Topology.

◦ The middle pane shows a hierarchical overview of existing topologies. On first
start the middle pane is empty.

2. In the right-hand pane click on the button Add location .

◦ The following dialogue opens.
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Figure 4. SBM Web UI - Building Configuration - Building Customization - Building
Topology - Add Location

3. Enter a descriptive location name and click on Add location .

◦ The middle pane shows the new location entry. This entry is automatically
selected.

◦ In the right-hand pane a new dialogue appears for adding a new building for the
selected location.

Figure 5. SBM Web UI - Building Configuration - Building Customization - Building
Topology - Add Building

4. Click on the button More options  to create a building with multiple identical floor
and room topology at once.

Smart Building Manager
Customizing Guide

- 7 -
© 2023 MICROSENS GmbH & Co. KG, All Rights Reserved



Figure 6. SBM Web UI - Building Configuration - Building Customization - Building
Topology - Add Building - More Options


For a more complex building topology it is possible to create floors
and rooms individually.

5. Enter a descriptive building name and select the number of floors and their respec­
tive rooms.

6. If room types are already defined, assign a room type for these rooms.

7. Click on the button Create building  to apply the changes. Click on the button Can­
cel  to discard them.

◦ The middle pane shows the new building topology in the path "Room automa­
tion".
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Figure 7. SBM Web UI - Building Configuration - Building Customization - Building
Topology - Building Complete

To add additional floors and rooms with differing topology follow these steps:

1. In the middle pane click on a specific topology element that you want to amend.

◦ In the right-hand pane the dialogues adapt accordingly:

▪ Location: Add new buildings.

▪ Room automation: Add new floors.

▪ Floor: Add new rooms.

2. Enter a descriptive name for the new building, floor or room and click on the but­
ton Add <element>  to apply the changes.

◦ The middle pane shows the changed building topology in the path "Room
automation".


It is possible to add a new location at any time by clicking on the but­
ton Add location  on top of the right-hand pane.

4.3. Modify Building Topology

It is possible to rename or delete elements or to change properties.

4.3.1. Rename Topology Elements

Follow these steps to rename a building’s topology element.
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1. In the middle pane click on a specific topology element that you want to rename
(e.g. a floor).

◦ In the right-hand pane the dialogue adapt accordingly (e.g. for a floor).

2. In the section Selected <element> click on the button Edit  (notepad icon)

◦ The dialogue expands, showing the element’s name in different languages.

Figure 8. SBM Web UI - Building Configuration - Building Customization - Building
Topology - Rename Element

3. Change the name in the respective language and click on the button Save .

◦ The middle pane updates the changed topology.

4.3.2. Delete Topology Elements

Follow these steps to delete a building’s topology element.

1. In the middle pane click on a specific topology element that you want to delete
(e.g. a floor).

◦ In the right-hand pane the dialogue adapt accordingly (e.g. for a floor).

Figure 9. SBM Web UI - Building Configuration - Building Customization - Building
Topology - Delete Element

2. In the section Selected <element> click on the button Delete  (trash bin icon) and
confirm the security prompt with Yes  to delete the specific element.

Smart Building Manager
Customizing Guide

- 10 -
© 2023 MICROSENS GmbH & Co. KG, All Rights Reserved



◦ The middle pane updates the changed topology.

4.3.3. Change Room Details and Device Assignments

Follow these steps to change room detais like room type and room number.

1. In the middle pane click on a room that you want to change.

◦ In the right-hand pane the dialogues adapt accordingly.

2. In the section menu:[Selected room] click on the button Edit room details   (gear­
wheel icon).

◦ The dialogue expands, showing the element’s details.

Figure 10. SBM Web UI - Building Configuration - Building Customization - Building
Topology - Change Room Details

3. Assign a defined room type by selecting an entry from the drop-down list under
Select room type.

4. Enter a room number.


This room number is for internal reference and does not correspond
to the room’s name! Therefore it is recommended to use descriptive
names for room names.

5. Click on the button Save  to apply the changes.

Follow these steps to assign devices to a selected room:

1. The section Manage devices lists all registered devices. Check the entry of the
device you want to assign to the room.
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Figure 11. SBM Web UI - Building Configuration - Building Customization - Building
Topology - Assign Device

2. Click on the button Assign device  to apply the assignment.

4.3.4. Change Global Configuration

For data monitoring and cost calculation it is possible to assign specific data such as
energy costs and savings.

Follow these steps to change the global configuration.

1. In the navigation pane select Building customization › Global configuration.

◦ In the right-hand pane the global configuration dialogue opens.
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Figure 12. SBM Web UI - Building Configuration - Building Customization - Building
Topology - Global Configuration

2. Change the following values as needed:

◦ Currency

◦ Energy price

◦ Number of trees per saved MWh

◦ CO2 emissions

3. Click on the button Save  to apply these changes.

4.3.5. Change Specific Building Configuration

For building specific data monitoring and cost calculation it is possible to assign
assumed energy consumption to a building.

Follow these steps to assign the specific building configuration.

1. In the navigation pane select Building customization › Building topology.

2. In the middle-pane select the build you want to assign a specific configuration.

◦ In the right-hand pane the respective dialogue opens
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Figure 13. SBM Web UI - Building Configuration - Building Customization - Building
Topology - Global Configuration

3. Change the following values as needed:

◦ Assumed annual energy consumption: This could be the last year’s energy
consumption of the building in total.

◦ Offset correction: If the monitoring does not start at the beginning of the
year, enter the actual consumption value.

◦ Offset correction: Check this option if you want to calculate with the given
offset.

4. Click on the button Save  to apply these changes.

4.4. Managing Building Topology using BIMXML Files

This section contains information about using the "Building Information Model" (BIM)
with Smart Building Manager. The BIM uses an XML schema to describe physical and
functional characteristics of buildings.

 Find general information on BIMXML at www.bimxml.org.

4.4.1. Exporting Building Topology into BIMXML File

To export a BIMXML file for creating a building topology, follow these steps:

to do 

4.4.2. Importing Building Topology from BIMXML File

To import a BIMXML file for creating a building topology, follow these steps:

to do 
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Chapter 5. Technic Tree
to do 
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Chapter 6. Data Points

6.1. Define Data point for a room based on Smart Director
Apps

If you use a SmartDirector in a room, the SmartDirector will expose all data points.

In this scenario, you must allocate each SmartDirector to the appropriate room in the
building structure.

6.1.1. Managing SmartDirectors

This section describes the steps to assign an existing SmartDirector to a room.

6.1.2. Pre-requisites

The prerequisites for assigning the SmartDirector are as follows:

• SBM Server is started.

• Valid SBM Server license is uploaded to the server.

• Valid login to the local computer.

• User account has the right to start SBM Client.

• Login to SBM Client as a user with at least "Smart Office sysadmin" rights (i.e. as
user "Super Admin" directly after SBM installation).

• The building structure contains at least one location, building, floor and room.

• Before assigning a SmartDirector, at least one SmartDirector must be discovered
and not yet assigned to a room.

6.1.3. Discovering SmartDirectors

To discover existing SmartDirectors within the corporate network, follow these steps:

6.1.3.1. 1. Go to Network Administration Perspective

Go to the menu item Window › Switch Perspective and switch to perspective "Network
Administration".

6.1.3.2. 2. Unlock Device List

In the main menu toolbar click on the "lock" symbol to unlock the device list configu­
ration.

• Configuration is locked. (closed key lock pad)

• Configuration is unlocked. (open key lock pad)

Confirm the upcoming notice dialogue.
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6.1.3.3. 3. Go to Left-Hand - Device List

On the upper left-hand pane activate the tab "Device List".

6.1.3.4. 4. Start MAC-Discovery

In the main menu select Insert › Device Auto Discovery.

Alternatively, click on the binoculars icon ( ) in the main menu toolbar and select the
menu entry "Device Auto Discovery".

NMP starts searching for available devices within the corporate network, showing an
indication dialogue box in the process.


Alternatively search for devices by IP range address scan or add the
device directly via the respective menu entry.

6.1.3.5. 5. Save discovery results

When finished, it shows a list of all devices available in the corporate network.

Select the respective device (in this case the new SmartDirector) by clicking on the
respective checkbox in the column "Add to list". Then click on the button Add to list  .

Click on "Close" to close the dialogue box.

6.1.3.6. 6. Lock and sync with server

In the main menu toolbar click on the "lock" symbol to lock the device configuration.

NMP Client synchronises its configuration with Server.

6.1.4. Assigning a SmartDirector to a Room


This step assumes that a SmartDirector was previously detected via
the server.

To assign a SmartDirector, follow these steps:

6.1.4.1. 1. Go to Building Administration Perspective

Go to the Window › Switch Perspective and switch to perspective "Building Administra­
tion".

6.1.4.2. 2. Unlock Building Structure

In the main menu toolbar click on the "lock" symbol to unlock the "Smart Building
configuration".

• Configuration is locked. (closed key lock pad)

• Configuration is unlocked. (open key lock pad)
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Confirm the upcoming notice dialogue.

6.1.4.3. 3. Reviw List of SmartDirector Devices

All of the available SmartDirectors are listed under the SmartDirectors tab in the lower
left-hand pane.


Unassigned SmartDirectors are displayed in blue font colour, assigned
SmartDirectors are displayed in black font colour.

6.1.4.4. 4. Drag SmartDirector to a room

In the tab SmartDirectors drag the specific SmartDirector with the left mouse button
and drop it to the desired room of the building structure.

The room itself becomes a building structure node, containing the designated Smart­
Director.

In the tab SmartDirectors the newly assigned SmartDirector changes its colour to
black.

6.1.4.5. 5. Drop the SmartDirector to a room

It is possible to drag and drop the assigned SmartDirector across all rooms of the
entire building structure.

6.1.4.6. 6. Lock and  sync with server

In the main menu toolbar click on the "lock" symbol to lock the "Smart Building con­
figuration".

SBM Client synchronises its configuration with Server.

6.1.5. Release a SmartDirector Assignment from a Room

To release a SmartDirector assignment from a room, follow these steps:

6.1.5.1. 1. Go to Building Adminstration Perspective

Go to the menu item Window › Switch Perspective and switch to perspective "Building
Administration".

6.1.5.2. 2. Unlock Building Structure

In the main menu toolbar click on the "lock" symbol to unlock the "Smart Building
configuration".

• Configuration is locked. (closed key lock pad)

• Configuration is unlocked. (open key lock pad)

Confirm the upcoming notice dialogue.
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6.1.5.3. 3. Select and delete

Select the specific SmartDirector whose assignment you want to delete under the
"Building Structure" menu. You can remove the SmartDirector by either clicking the
appropriate icon () on top of the tab "Building Structure" or by opening the context
dialogue (right mouse click) and selecting "Delete selected".

In the tab SmartDirectors, the previously released SmartDirector changes its colour
from black to blue.

6.1.5.4. 4. Lock and sync with servere

In the main menu toolbar click on the "lock" symbol to lock the "Smart Building con­
figuration".

SBM Client synchronises its configuration with SBM Server.

6.2. Datapoint design based on MQTT Data

6.2.1. Introduction

The definition of the data points are the backbone of every building management sys­
tem.

Every definition of a data point is based upon an information model. See Data Model
Guide for more details. The Smart Building Server’s data collecting service is responsi­
ble to gather all the data value.

To obtain the data, the following communication protocols are supported:

• Smart Office - HTTP Pull Service based on XML files

• MODBUS - Register Polling service

• MQTT - Publish / Subscribe Service


MQTT-based data points are separate from the edge device itself. (Loos
Coupling)

6.2.2. Design the data point

Every data point definition is an instance of an "DataPoint Entity Type". The list of the
supported "DataPoint Entity Type" are defined in the "Data Model Guide".

6.2.3. Import data point Definitions

The Import function of the MQTT based data point definitions is very powerful and
allows customizing engineers to create thousands data points in one step. Each data
point definition refers to the technical context (technical data source) as well as to the
business context (like building location and usage info)
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6.2.4. Summary Step

The list below contains the major steps for using MQTT based data-points and how to
import the data point definitions

1. Create a CSV Datapoint Design Sheet: Using a CSV sheet to define the data-points
from the MQTT perspective.

2. Upload the .csv-file to the SBM Server

3. Review the uploaded information in the SBM Portal

6.2.5. Create Datapoint Design sheet as CSV file

You may use any editor you like to create a .csv-file.

Every .csv-file contains

• one header row

• one or more data rows

6.2.5.1. Header Row

The header row has to contain the following column names

Name, DataPointClass, ReadWriteMode, MinValue, MaxValue, SaveHistory, LogOnValueChange,
MQTT-Topic, MQTT-Retained, Context

The table below contains the description for each column name

Column
Name

Purpose Possible values Required

Name Human readable name used
as mnemonical identifier for
the data point

Text : a-zA-Z0-9_- mandatory

DataPoint­
Class

Define the type of the data­
point entity

names are defined in Data
Model Guide

mandatory

ReadWrite­
Mode

Defines the access mode enum = READONLY, READWRITE mandatory

MinValue Value are optional. If a
value is given then a rule
will be generate to activate
an alarm if the value is less
than the given value

can be empty or contains a
number

optional
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MaxValue Value are optional. If a
value is given then a rule
will be generate to activate
an alarm if the value is
greater than the given
value

can be empty or contains a
number

optional

SaveHistory Defines if the value has to
be stored in the database
(internal and also in an
external like InfluxDB).

boolean: True, False mandatory

LogOnVal­
ueChange

Defines if the data has to
be logged in the database if
value has changed

boolean: True, False mandatory

MQTT-Topic Defines the unique topic
name - recommended to
use a prefix like client-ID
for each topic to make it
unique. In some cases you
want to use the MAC-
Address of the device which
publishes the values to
keep it simple. In a more
sophisticated approach you
could use a "service name"
as pre-fix. This is used by
devices which support the
"Zero Configuration Net­
work" standard like "Bon­
jour" on Windows, Apple
and Linux Systems.

see Data Model Guide ,
Section MQTT Schema

mandatory

MQTT-
Retained

MQTT retain value mandatory

Context Defines the context of the
data point. The context
defines if the datapoint will
be used for a technical
device (technic tree) or for
a building area like a room
(Builing Structure)

syntax: bt://<building-path
or tt://<technic-path

mandatory

6.2.5.2. Data Row

Each data row contains the values for the different columns

6.2.6. Upload the CSV file to the SBM Server

The steps arte:
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1. Login to the SBM Portal as user who has the permission to upload Datapoint Design
Design sheet

2. Go to Buildingcustomizing › Datapoint configurtion

3. Click on Import datapoints from file   

4. Select the .csv-file and apply in order to upload the .csv-file

6.2.7. Review the uploaded information in the SBM Portal

After the upload of the .csv-file, the list of all data points are shown in the data point
list.

6.3. Managing History Data

6.3.1. Enable Data Point History Data Tracking

It is frequently necessary to monitor the value of data points in order to display the
data on a chart.

For each data point, the tracking of historical data can be enabled or disabled. "History
tracking" is disabled by default.

To enable "history tracking", the SBM Client must be used.


For each data point where history data is enabled, a default chart is
generated in the WEB UI. For more details, read the documentation on
customizing Chart in the WEB UI.

6.3.2. Enable History data tracking for a data point related to
rooms

The steps are: . Start the SBM Client . Login as a valid user who has the "building
admin" permissions . Switch to the "Building Administration" perspective

1. Unlock the "Building Structure/Technic"

2. Go to the building structure and select the room node where you want to track his­

Smart Building Manager
Customizing Guide

- 22 -
© 2023 MICROSENS GmbH & Co. KG, All Rights Reserved



tory data.

3. Go to the right-hand panel and select the TAB "data points"

4. Go to the row which contains the definition of the data point that should be tracked

5. Go to the column "history data" and use the checkbox to enable / disable history
data tracking. If the box is checked then "history tracking" is enabled otherwise it
is disabled.

6. Lock the "building structure" to save the settings in the "SBM Database".

6.3.3. Enable History data tracking for a data point related to
technic tree node

The steps are:

1. Start the SBM Client

2. Login as a valid user who has the "building admin" permissions

3. Switch to the "Building Administration" perspective

4. Unlock the "Building Structure"

5. Go to the "Technic Tree structure" and choose the node where you want to track
data.

6. Go to the right-hand panel and select the TAB "data points"

7. Go to the row which contains the definition of the data point that should be tracked
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8. Go to the column "history data" and use the checkbox to enable / disable history
data tracking. If the box is checked then the tracking is enabled otherwise it is dis­
abled

9. Lock the "building structure" to save the settings in the "SBM Database".

6.3.4. Understand the History Data Tracking using the SBM
Database

When a device polls a data point value and the value is different from a previously
polled value, the value is saved in the "SBM database".

There is no distinction between polling MODBUS devices and SmartDirector devices.

In addition to polling for data, the SBM also retrieves data values from a MQTT broker
in the event that the device publishes data over MQTT. Configuring the MQTT Broker is
possible. Please refer to the documentation on the MQTT Broker setting inside the
server configuration for more information.

6.3.5. Understand the History Data Tracking using a Time
Series Database

In addition to the "SBM Database", all historical data may also be kept in a "Time
Series Database". This requires that the "INFLUXDB integration" be enabled in the
server settings.

If INFLUXDB is enabled, every data value (polled or published) is saved in the "time
series database". This is also true if the data value is the same as the preceding data
value.

See the server settings and "INFLUXDB integration" document for additional informa­
tion on the "INFLUXDB integration".

6.4. Using Datapoints from Modbus Devices

6.4.1. Add Modbus Device Manually

1. Start the SBM Client

2. Login as a valid user who has "network administration permission"

3. Switch to the "Network Administration"

4. Select Device List in the menu bar

5. Select the sub-menu item "Add ModBus device" to launch the dialog to define the
modbus device
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Figure 14. Add Modusbus Device menu

6.4.2. Define Data point Definitions manually

The steps are:

1. Select previously added ModBus device and use context menu to launch dialog for
editing

2. Define ModBus registers

3. Defined ModBus registers will automatically be imported as "DataPoints" at the
"SBM application"

6.4.3. Import Data point Definition for MODBUS Devices

The steps are as follow:

1. Create a .csv file which contains the definition of the devices and registers that are
used for the data points.

2. Login to the SBM Portal

3. Go to "Building customizing"

4. Go to "Data point configuration"

5. Upload / Import the .csv-file for MOD Busdevices

6.4.4. Format of the MODBUS Data point design sheet

Please create a sheet with the columns below.

 Columns must be in the same order as listed in the table below

Column
Name

Is Manda­
tory

Description Data type Sample
Data

Modbus
Device IP

yes IPv4 Address of the
MODBUS device

IPv4 adress 10.100.90.
242

Port yes Port

Device
name

yes Mnemonic identifier/
name of the device

String Fan1

Register
name

yes name of the MODBUS
register

string switchCon­
trol
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Column
Name

Is Manda­
tory

Description Data type Sample
Data

Register
type

yes type of the MODBUS
register

enum value; supported
types are:

* HOLDING_REGISTER
- used for 16 bit words
that can be altered

* INPUT_REGISTER -
used for 16 bit words
that are read only

* OUTPUT_COILS -
used for Boolean values
that can be altered

* DISCRETE_INPUT -
used for Boolean val­
uea that are read only

HOLD­
ING_REG­
ISTER

Register no yes number of the register unsigned integer 0

Bit no yes number of the bit that
has to be evaluated

unsigned integer 2

Read write
mode

yes defines if the bit of the
register can be set

boolean; false= READ­
ONLY, true=READWRITE

false

DataPoint­
Class

yes Name of the SBM data
class

see documentation
about the supported
data point classes

COUNTER

Context yes defines the context;
can be room related
value or technic node
related value

see documentation
about the supported
data point classes

bt://myLo­
ca­
tion/Main­
Buil­
ing/Floor1/
Meet­
ingRoom1

Min value no

Max Value no

Save his­
tory

no used to control whether
the data values have to
be stored as a time
series

boolean true
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Column
Name

Is Manda­
tory

Description Data type Sample
Data

Log on
value
change

no used to control whether
a value change should
be logged

boolean false

Signed
value

no defines if the value is
signed value

boolean false

Real no defines if the value is of
data type real

boolean false

Transfor­
mation

no defines if transforma­
tion of the values is
required

boolean true

Transfor­
mation
operator

no

Transfor­
mation
value

no defines the kind of
transformation

òperatorn sign` * ; (Multi­
ply)

Value map no defined values for value
mapping

<value> = <name> 1= auto ;
2=start;
3=stop

Description no short description of the
data point

string of/off state
of the fan
1
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Chapter 7. Building Status

7.1. Customize the Room status  cards and room
visualization

This section describes how to customize the SBM Portal’s Building Status information.

7.1.1. Pre-Requisites

• Launch the SBM WEB UI.

• Sign in as valid user who has the permission to use the "building status editor".

• Datapoints are already configured .

• Go to "Building customization"

7.1.2. Overview

The key parts to customize the building status are listed below.

• Customize the "Room Cards"

• Customize the "room visualization"

7.1.3. customize Room Cards

7.1.3.1. Summary Steps

• Verify that "data point definitions" are available in SBM Portal.

• Go to BuildingCustomization › Room Card Templates.

• Copy existing template.

• Click on "Type and Template Configuration".

• Assign "RoomType" and "RoomTemplate" to the rooms.

• Edit the copied template.

• Define the Icons which are shown on the "Room Card".

• Define the Panels that are shown in the "Room Visualization" view.

• Save the "Room Template" definition.

7.1.3.2. Room Card  Template Overview

The SBM Portal comes with few templates.

A template is used to simplify the definition of "Building Status Cards" for rooms, as
displayed in the "Building Status pane".

The basic idea behind the "Room Template" are as follows:
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• use a template for each room type.

• set the roomtype for each room.

 There is no need to create a "room template" for each room.

The "room template" defines the icons, data panels and visualization of the Builing
Status Cards.

Figure 15. Room Card Customizing model

7.1.3.3. Edit the Room Card Template

The editor allows you to define:

• What Icons should be visible in the status card.

• Connect the Icons with the datapoint which represents the Icon.

• What Panels have to be shown in the "Room Visualisation".

• Define the list of datapoints that are visible in each Panel.


The concept of "Room Types" and "Room Card Tem­
plates" allows switching between different card-tem­
plates without changing the room type.

7.1.4. customize Room Visualization
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7.1.5. Summary Steps

• Go to "Buidling customisation".

• Click on "Visualization templates".

• Create a "visualizaion template".

• Assign the "room visualiation template" to a room.


The concept of "Room Types" and "Room Visualisa­
tion Templates" allows switching between different
card-templates without changing the room type.

7.1.6. Create Room Visualization Template

The basic steps for the creation of a "room visualization template" are:

• Upload a SVG file whcih represents the room type.

• Add the visual elements icons to the SVG file.

• Link the visual elements to the data points, which are only applicable to rooms and
are listed in the "data point list".

• Save the template.


The visualization template type is derived automati­
caly from the type of the connected datapoints.

7.1.6.1. Review the settings

• Go to "Building Status".

• Select a Building.

• Verify the Icons on a "Room Card".

• click on a "Room Card".

• Verify the "Room Viualization" and the "Data Panels".

7.1.7. Customize Room Visualization

The are two options to create visualizations for rooms:

• Create a visulaization for an individual room

• Create a template for a room type

7.1.7.1. Summary Steps

• Verify that "data point definitions" are available in SBM Portal

• Go to BuildingCustomisation › Visualizations

• Create a new template
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• Save the "Room Visualization" definition as a "room-template"

7.1.7.2. Visualization using Room Templates

A template is used to simplify the definition of "Building Status Cards" for rooms, as
displayed in the "Building Status" pane.

The following is the basic concept of the room template:

• Set the room type for each room

• Asign a template for a room type

 There is no need to create a "room template" for each room.

The "room visualization template" defines the visualization of the "Building Status
Cards"

7.1.8. customize Room Visualization for an individual room

7.1.8.1. Summary Steps

• Go to "Buidling customisation"

• Click on "Visualization templates"

• Create a "visualizion template"

• Assign the "room visualiation template" to a room


the concept of "Room Types" and "Room Visualiza­
tion Templates" allows switching between different
card-templates without changing the room type.

7.1.8.2. Create Room Visualization Template

The basic steps for the creation of a room visualization template are:

• Upload a SVG file whcih represents the room type.

• Place the visual elements' icons to the SVG file.

• Connect the visual elements to the data points, which are only applicable to rooms
and are listed in the "data point list".

• Save the template for an individual room.


The visualization template type is derived automati­
caly when the visualization definition is saved.

7.1.8.3. Review the settings

• Go to "Building Status"

• Select a Building
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• Verify the Icons on a "Room Card"

• Click on a "Room Card"

• Verify the "Room Visualization" and the "Data Panels"

7.2. Customize the visualization for floors

This section contains information on how to customize the floor visualization.

7.2.1. Pre-Requisites

• Launch the SBM WEB UI.

• Login as valid user who has the permission to use the building status editor.

• Datapoints are already configured.

• Go to "Building customisation".

7.2.2. customize Floor Visualization

7.2.3. Summary Steps

• Go to "Buidling customisation".

• Click on "Visualizations".

• Create or edit a "floor template".

• Save the template for an indivisual floor.

7.2.4. Create a Floor Visulaization

The basic steps for the creation of a "floor visualization" template are:

• Upload an SVG which represents the floor.

• Give the template a name.

• Place the visual elements (icons) in the floor plan.

• Connect the visual icons with data points as listed under "Building Data points".

• Save the template for an individual floor.

 The visualization will be visible under "Building Status".

7.2.4.1. Review the settings

• Go to "Building Status".

• Select a Building.

• Select the floor for filtering.

• Click on the button with the "layer" Icon in the upper right corner to switch the
view to the "floor visualization".
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Chapter 8. Alarm and Event Handling

8.1. Using the Alarm and event centre (AEC) of the SBM WEB
UI

8.1.1. Pre-Requisite

Log in as a valid user who is permitted to use the AEC.

8.1.2. AEC Overview

The core functions of the AEC are:

• User defined alarm rules

• List of events iincluding filtering

• List of active alarms including filtering

• Use filters to list alarm history

8.1.3. The Alarm Panel

To open the "Filter" panel, click on the "Filter" icon at the top of the table.

8.1.4. The Event Panel

The "Event" panel shows a list of all received events.
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The following action are available:

• filter events

• export events

8.1.5. The Alarm Rules Panel

If you select "Alarm Rules" from the navigation bar, a list of "Alarm Rule Definitions"
will appear as shown below.

The core functions are:

• Define a new alarm rule.

• Modify an existing definition.

• Delete a definition.

• Search for a particular alarm rule definition.
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8.1.6. Create or update Alarm Rule definitions

You can define a new alarm rule by selecting the +ADD  button at the top of the table.

The Alarm rule editor will open if you click the "Edit" icon for an Alarm rule and will
allow you to update or modify an existing Alarm rule definition. See example below:

The "WHEN" section specifies the circumstances under which an Alarm rule should be
activated. The "THEN" action specifies what should occur when an alarm rule acti­
vates.

Definitions for import and export alarm rules: Alarm rule definitions can be transferred
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from your test environment to your production environment using the export and
import function.
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Chapter 9. Task Scheduling

9.1. Using the Scheduler for automation

This section contains a desciption on how to use the SBM Scheduler to define and
automate the execution of tasks. The customizing can be done via SBM Portal.

9.1.1. Pre-Requisites

• SBM Server is started

• Sign in as a valid user who has the permission to use the SBM Scheduler

• Click on "Scheduler" in the navigation bar

9.1.2. Introduction

If you click on the menu item menu:[Schedules] in the navigation bar, then you get
access to the following core functions of the scheduler (See also: screenshot below)

• List of defined Schedules

• List of defined Taks that can be excuted

• List of Task History

• Calendar view
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9.1.3. The Basic workflow

The basic procedures in using the scheduler for automation are briefly described in the
list below.

1. define a schedule

2. define a task

3. use the calendar view for review

4. review the test execution

9.1.4. Define Schedules

• open List of schedules
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• click on ADD  button to add a schedule definition

9.1.5. Define Tasks

9.1.6. Review Schedules using the Caledenar View

9.1.7. Review the execution of  tasks
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Chapter 10. Charts

10.1. Customizing Charts

The SBM Portal makes it very simple to create and use both custom and pre-defined
charts.

10.1.1. Pre-Requisites

• Launch the SBM Portal in the WEB Browser.

• Login as a valid user who has the permission to customize charts.

• Click on the menu item Charts in the main navigation bar.

10.1.2. The core features

• Use built-in charts

• Use custom single line charts

• Use custom multi-line charts

• Use Global Charts

10.1.3. Using built-in charts

Built-in charts are automatically generated for every value of a data point whose
"Save History" option is activated.

10.1.4. Custom Charts

SBM Portal allows users to build custom charts based on a specific parameter. A wizard
directs users through the process of making a custom chart.
The basic steps are:

1. Select a chart type like

◦ Line chart

◦ Bar chart

◦ Area chart

◦ Custom defined chart (e.g. multiline)

2. Select chart data

3. Provide summary information like chart name, chart group name, etc.

10.1.5. Global charts

Global charts are created by default and used to show global consumption values, like
power.
This requires that values from the corresponding data points are defined and assigned
to the building topology.
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Chapter 11. Data Dashboard

11.1. Custom Dashboard

The SBM Portal provides a Dashboard for the visualization of data from a building or
technical device.

The dashboard enables the definition of personalized dashboards. Additionally, it
includes a "Standard ECO Dashboard".

11.1.1. Pre-Requisites

• Launch the SBM Portal in your Web Browser.

• Login a as valid user who has permission to customize Dashboards.

• Click on Dashboard  in the main navigation bar.

11.1.2. Core features of Custom Dashboards

• Create one or more dashboards.

• Add one or more data panels to a dashboard.

• Add one or more widgets to a data panel.

• Define the layout of the data panel, like position and size.

11.1.3. Dashboard  Editor

The core features of the editor are

• Add, update and delete a Dashboard.

• A Dashboard may contain one or more grids.

• Each Grid may contain one or more widgets for the data visualization.



+ It is usual practice to create a custom chart in the
Charts › Custom panel when it comes to charts.
Each custom chart can later be used again in a
chart widget. This is particularly accurate when
using multi-line charts.

11.1.3.1. List of available widges

• Label

• Alarm List

• Table

• Charts

• external web site
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11.1.4. The Standard ECO Dashboard

The "Standard ECO Dashboard" displays the following parameters for:

• Current Power Consumtioon

• Total Power Consumption this year

• Volume of saved CO2 because power was saved

• Number of trees which consumes the saved CO2 volume

In addition to the four parameters listed above, custom charts can be added if
required.

Smart Building Manager
Customizing Guide

- 42 -
© 2023 MICROSENS GmbH & Co. KG, All Rights Reserved



Chapter 12. 2-D-Density Plots

12.1. 2D-Density Plots

"2D-density plots" are used to display the distribution of data point values on a build­
ing area in a 2D view.

12.1.1. Summary Steps

• Go to 2D-densityplots › Add new 2-D density plot in the navigation bar.

• Upload an SVG graphic of a building area, such as a floor or room plan.

• Define a name for the plot

• Define one or more points in the graphic where the raw data’s source is provided.

• Assign a data point to each plot point.

• Change the charts' dimensions and color

• Save the plot by clicking the Save  button.

12.1.2. Important hints

• This type of representation is sometimes referred to as HEATMAP, which is incorrect
in this context. The name "heatmap" is only used to describe a certain type of cat­
egorized data visualization.

• "2D-density plots" are difficult to read and are typically utilized by data experts
rather than regular users.

• The 2D-plots do not provide data specifics and can only be used to gain an
overview of queries such as:
Where are … data located
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Chapter 13. Zone View

13.1. Customize Zones

The SBM Portal allows zone definition. The "Building Administration" can define a
"Zone" as a specific building area. A zone’s function is to demonstrate and regulate a
particular activity, such as lighting a specific building area.

13.1.1. Pre-Requisites

• Open the SBM Portal in a WEB Browser.

• Sign in as a valid user who has the permission to customize zones.

• Select "Zones" from the main navigation bar.


In case the "Zones" menu item is not visile on the main navigation bar
you can add it manually. Just add a menu entry with the Title "Zones"
and the Url /zones

13.1.2. Overview about Zones

The major functions performed by the "Zone support" are listed below.

• Scan for existing "zones"

• Configiure the data that are relevant for the zones

• Visualization of the "zone" data

Smart Building Manager
Customizing Guide

- 44 -
© 2023 MICROSENS GmbH & Co. KG, All Rights Reserved



Chapter 14. Using Design Sheets

14.1. Scope

The following explanation provides some basic, step-by-step instructions for quickly
customizing an "SBM Server instance" for a specific building.

You will learn how to use a "data point design sheet" for MQTT usage, which contains
the majority of the customization data, and upload it to the "SBM Server instance".


The same approach can be followed when using a MODBUS "data point
design sheet".

14.2. First Steps

The first steps are:

1. Create a "data point design sheet".

2. Upload the "data point design sheet" to the "SBM Server instance".

3. Review the imported information.

14.2.1. Create Data Point Design Sheet

1. Open your preferred spreadsheet editor.


The spreadsheet editor shall be able to export sheet data in .csv
format. The "data point design sheet templates" provided by
MICROSENS are available as .xlsx files (Microsoft Excel ®).

2. Fill out the columns and rows as requested.

3. Export the sheet as .csv file.


It is recommended to save the file in the editor’s native format for
convenient editing.

14.2.2. Upload to SBM Server instance

1. Launch the SBM Server Manager and start the server instance.

2. Open the SBM Portal in your browser.

3. Login as a valid user who has the permission to import the "data point design
sheets".

4. Go to BuildingCustomisation › Data point configuration.

5. Click on Import datapoints from file   .

6. Select the .csv file from your local disk.

7. Upload the selected file.
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14.2.3. Review Imported Information

To make sure the "data point design sheet" works as expected, review the following
data:

• Building topology

• Technic tree

• Data point configuration list

• Data point assignment


In the event of a failure, it is advised to modify the "data point design
sheet" and import the data again. This way, the valid "data point
design sheet" can be reused.

14.3. Advanced Customizing Steps

The following actions must be taken after MQTT Data point configuration is complete:

14.3.1. Customize Building Status (Room Cards and Panels)

1. Go to BuildingCustomisation › Room Card Templates.

2. Add building specific "room types".

3. Copy predefined room templates.

4. Adjust the "room types" to your rooms.

5. Assign "Room Card Templates" to "room types".

6. Assign "room types" to rooms.

14.3.2. Customize Room Visualization

1. Go to BuildingCustomisation › Visualizations.

2. Create a "visualization template" for either a "room type" (room template) or for
an individual room.

3. Assign the "visualization" of the room to an individual room or a room type.

4. Create a "visualization" for an individual floor.

5. Assign the "visualization" of the floor to an individual floor.
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Our General Terms and Conditions of Sale (GTCS) apply to all orders (see
https://www.microsens.com/fileadmin/files/downloads/Impressum/MICROSEN­
S_AVB_EN.pdf).

Disclaimer

All information in this document is provided 'as is' and is subject to change without
notice.

MICROSENS GmbH & Co. KG disclaims any liability for the correctness, completeness
or quality of the information provided, fitness for a particular purpose or ensuing dam­
age.

Any product names mentioned herein may be trademarks and/or registered trade­
marks of their respective owners.

©2023 MICROSENS GmbH & Co. KG, Kueferstr. 16, 59067 Hamm, Germany.

All rights reserved. This document in whole or in part may not be duplicated, repro­
duced, stored or retransmitted without prior written permission of MICROSENS GmbH
& Co. KG.
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